BIMM-143: INTRODUCTION TO BIOINFORMATICS (Lecture 1)

Bioinformatics Databases and Key Online Resources
http://thegrantlab.org/bimm143/
Dr. Barry Grant

Overview: The purpose of this lab session is to introduce a range of bioinformatics
databases and associated services available on the Web whilst investigating the
molecular basis of a common human disease.

Sections 1 and 2 deal with querying and searching GenBank, GENE and OMIM
databases at NCBI. Sections 3 and 4 provide exposure to EBI resources for comparing
proteins and visualizing protein structures. Finally, section 5 provides an opportunity to
explore these and other databases further with additional examples.

Side-note: The Web is a dynamic environment, where information is constantly added
and removed. Servers "go down", links change without warning, etc. This can lead to
"broken" links and results not being returned from services. Don't give up - give it a
second go and try a search engine using terms related to the page you are trying to
access.

Section 1
The following transcript was found to be abundant in a human patient’s blood sample.

>examplel
ATGGTGCATCTGACTCCTGTGGAGAAGTCTGCCGTTACTGCCCTGTGGGGCAAGGTGAACGTGGATGAAG
TTGGTGGTGAGGCCCTGGGCAGGCTGCTGGTGGTCTACCCTTGGACCCAGAGGTTCTTTGAGTCCTTTGG
GGATCTGTCCACTCCTGATGCAGTTATGGGCAACCCTAAGGTGAAGGCTCATGGCAAGAAAGTGCTCGGT
GCCTTTAGTGATGGCCTGGCTCACCTGGACAACCTCAAGGGCACCTTTGCCACACTGAGTGAGCTGCACT
GTGACAAGCTGCACGTGGATCCTGAGAACTTCAGGCTCCTGGGCAACGTGCTGGTCTGTGTGCTGGCCCA
TCACTTTGGCAAAGAATTCACCCCACCAGTGCAGGCTGCCTATCAGAAAGTGGTGGCTGGTGTGGCTAAT
GCCCTGGCCCACAAGTATCACTAAGCTCGCTTTCTTGCTGTCCAATTT

The only information you are given is the above sequence so you must begin your
investigation with a sequence search - for this example we will use NCBI's BLAST
service at: http://blast.ncbi.nlm.nih.gov/

Note that there are several different “basic BLAST” programs available at NCBI
(including nucleotide BLAST, protein BLAST, and BLASTX).

Q1: Which BLAST program should we use in this case?
[HINT, what type of sequence are you provided with]
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Searching against the “Nucleotide collection” (NR database) that includes GenBank is
a good place to start your investigation of this sequence.

Q2: What are the names and accession numbers of the top four hits from your
BLAST search?

Q3: What are the percent identities for the top few hits?
[HINT: scroll down to the alignment section of your BLAST result page for details of
matched nucleotides]

Q4: How many identical and non identical nucleotides are there in your top hit
compared to your last reported hit?

From the results of your BLAST search you can link to the GENE entry for one of your
top hits. This link is located under the “Related Information” heading at the right hand
side of each displayed alignment (i.e. scroll down to the “Alignments” section).

Q5: What is the “Official Symbol” and “Official Full Name” for this gene?

Q6: What chromosome is this gene located on?

Q7: What are the names of neighboring genes on this chromosome?

Q8: How many exons and introns are annotated for this gene?

Q9: What is the function of the encoded protein?

Q10: Does the protein have a role in human disease(s)? If so what diseases?

[HINT: Scroll down to the “Phenotypes” section of the GENE entry page and also
explore the link to the OMIM database]

Section 2.

By now you should be aware that the example sequence corresponds to human sickle
cell beta-globin mRNA and that this disease results from a point mutation in the 8 globin
gene. In the following section, you will compare sickle cell and normal 3 globin
sequences to reveal the nature of the sickle cell mutation at the protein level.

To do this you need to find at least one sequence representing the normal beta globin
gene. Open a new window and visit the NCBI home page (http://www.ncbi.nim.nih.gov)
and select “Nucleotide” from the drop menu associated with the top search box. Then
enter the search term: HBB
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Note that lots of irrelevant results are returned so lets apply some “Filters” (available by
clicking in the left-hand sidebar) to focus on RefSeq entries for Homo sapiens.

Remember that we are after mRNA so we can compare to the mRNA sequence from
section 1 above.

Q11. What is the ACCESSION number of the “Homo sapiens hemoglobin, beta
(HBB), mRNA” entry?

NOTE: Boolean operators (NOT, AND, OR) as well as fielded queries (i.e. “HBB[ Gene
Name] AND Human[Organism]”) can be used in ENTREZ searches to filter results
for more efficient searching.

Select “Homo sapiens hemoglobin, beta (HBB), mBNA” from the results and scroll down
to the FEATURES section to answer the following.

Q12: What are the numbers of the first and last base positions of exon 1 of this entry?
[HINT: You can also find this from selecting the “GRAPHICS” display and placing your
mouse over the first exon (see Figure).]

Q13: What are the numbers of the
first and last base positions of the
[HINT: CDS or “coding sequence” o e et (B8, mRNA :
refers to the portion of a genomic —
DNA sequence that is translated,

from the start codon to the stop
codon. Successful translation of a
CDS results in the synthesis of a
protein.]

Section 3.
Here we will compare the retrieved sequences by creating a sequence alignment. This
will make the difference between the two sequences easy to spot.

To generate the alignment, we will use MUSCLE available on the EBI website
at: http://www.ebi.ac.uk/Tools/msa/muscle/

Select the FASTA display for the “Homo sapiens hemoglobin, beta (HBB),
mRNA” (NM_000518) entry from section 2.
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Now copy-and-paste this FASTA format sequence and also the example1 sequence
from section 1 into the input box of the MUSCLE page. Then click the submit button
(see red circle in Figure below).

O Vw20l SR Toots maamuscie] =] If your alignment is incomplete,
SMELES e please wait until the page
MUSCLE refreshes. If the job appears to

. be in an undefined state try
Input form = Web services | Help & Documentation <. Share | ® Feedback C“Cklng refresh Untl| a result |S
Tools > Multiple Sequence Alignment > MUSCLE retu rned .

Multiple Sequence Alignment
MUSCLE stands for MUItiple Sequence Comparison by Log- Expectation. MUSCLE is claimed to achieve both
better average accuracy and better speed than ClustalW2 or T-Coffee, depending on the chosen options.

STEP 1 - Enter your input sequences

The two sequences should now

Enter or paste a set of sequences in any supported format

ATGGTGCATCTGACTCCTGTGGAGAAGTCTGCCGTTACTGCCCTGTGGGGCAAGGTGAACGTGGATGAAG H H
TTGGTGGTGAGGCCCTGGGCAGGCTGCTGGTGGTCTACCCTTGGACCCAGAGGTTCTTTGAGTCCTTTGG be allgned' Where the allgned
GGATCTGTCCACTCCTGATGCAGTTATGGGCAACCCTAAGGTGAAGGCTCATGGCAAGAAAGTGCTCGGT u nC r id ntiC I n * i
GCCTTTAGTGATGGCCTGGCTCACCTGGACAACCTCAAGGGCACCTTTGCCACACTGAGTGAGCTGCACT
GTGACAAGCTGCACGTGGATCCTGAGAACTTCAGGCTCCTGGGCAACGTGCTGGTCTGTGTGCTGGCCCA Seq e eS a e e a ’ a S
TCACTTTGGCAAAGAATTCACCCCACCAGTGCAGGCTGCCTATCAGAAAGTGGTGGCTGGTGTGGCTAAT H
GCCCTAGCCCACAAGTATCACTAAGCTCGCTTTCTIGCTGTCCAATTT ) placed under the alignment.
e ey RS Examine the results and note
STEP 2- Sot your Parameters that your sequences are nearly

e e identical. However, being much

The default settings will fulfill the needs of most users and, for that reason, are not visible.

Nrw GRS (Chck bre, N you want 1 view or hange fhe defull etings,) shorter, the sickle cell sequence

S — has many padding gap

Be notified by email (Tick this box if you want to be notified by email when the results are available) CharaCterS ( """ ) tO brlng
@ equivalent regions into the

correct register.

When inspecting alignments (especially those with lots of sequences) it can be helpful
to use a graphical user interface (or GUI) to display colored, interactive and scrollable
versions of your alignment. One such GUI is the seaview program.

From your muscle results web page click Download Alignment File. Note that if a
download does not automatically begin then you may need to save the resulting plain
text page from your web browser via File > Save As...

Next download seaview for your computer from: http://doua.prabi.fr/software/seaview

Once downloaded open seaview by double clicking on it’s icon (most likely in your
Downloads folder) and then select File > Open > and select your muscle alignment
results. A colored version of your alignment should now be displayed.

See if you can now use seaview to answer the following 3 questions:
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Q14: How many gap characters (-) are added to the beginning of the sickle cell beta-
globin sequence in order to align it with the beta globin sequence? How might you
have guessed this number from information you read in the GenBank annotation?
[HINT: See section 2, Q13]

Q15: Ignoring ambiguity codes (Y and N), what are the differences between the two
sequences? [HINT: There may be more than one]

Q16: Which codon position from the start of the sickle cell sequence would this
difference affect? What amino acid would the different codons encode in the two
sequences?

[HINT: use the codon table below to help.]

Second base

UUU_Phenyl- UCuUT] UAU e uUGU tol U
B vuc I aanine Fluece | Sarfie UAC]_ yrpskiecY uac]_cys eine C J
UUAT, o cine T UCA S UAA Stopcodon | UGA Stop codon [
uue |~ -°uene L (uce. UAG Stop codon | UGG \Y]Tryptophan G
CuuT CCUT CAUT ... CGU U
— Histidine -
lef CUC L) eucine L. | €CC L proline CAC: £ac — Arginine c
o [l cuA CCA P |caa _ |caa A
& CUG._ CCG. CAG_—G'Utam'"(b CGG._ G
2 AUU T | ACUT AAU 7 : AGUT y

" B AUC [-Isoleucine | ACC | aac JAsparagine | pqc [~Serine S ey
— Threonine N C
8 AUA . ACA " AAA AGA A

ethionine | ACG _| AAG [ Lysine AGG — Arginine
AUG Mtart codon = K = R K
GUU GCU GAUT_Aspartic | GGU] U
GUC : GCC . GAC acid ) |GGC : -

G — — Glycine
GuA [~ Valine V GCA Alanlni\ Has— Chaic |GG . -
GUG GCG_| GAG | acid | |GGG- G

Section 4

In this section we will retrieve and visualize the 3D protein structure of sickle cell
haemoglobin. The aim here is to ascertain how the Glu6 -> Val6 mutation might cause
the mutant molecules to oligomerise into fibers, hence deforming erythrocytes. This will
require you to examine the structural context of the mutation in the 8 globin chains.
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We could find sickle cell haemoglobin structures via a text search of main PDB website
@ http://www.rcsb.org/. However, as we know the nucleotide sequence from our
previous work, lets use BLASTX to search the PDB database from the NCBI site.

To do this visit http://blast.ncbi.nim.nih.gov/ select the appropriate BLAST program and
make sure the database you are searching against is set to “Protein Data Bank (pdb)”.

Note the accession numbers and alignment statistics for the top few hits.

Q17: Is there a PDB structure with 100% identity to your examplel query sequence?
[HINT: this might not be the top listed hit]

For this section we will use the online NGL Viewer, which has more advanced
display options than the viewers currently available at NCBI or the PDB itself.

Open a new window, visit the webpage: http:/nglviewer.org/ngl/

Once loaded, dismiss any splash screen instructions (a.k.a introduction
message).

€« C' [ proteinformatics.charite.de/ngl/html/ngl.html

: Click on the File button,
File V aw Examples Plugins Help NERVETECES ond enter the PDB

Open... ® @ % code 1HBS in the
appropriate box and
®asTrajectory ~ — Overview press return.
File View Examples Plugins Help NGL Viewer 0.6dev
- Nl
5 Left click the menu icon
L to the right of the listed
PDB file entry (in our case
prsbevimle ™) - “1HBS” as this was our
S PDB code) and set
Structure “Assembly” to “AU”.

File www.rcsb.org/pc
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NGL Viewer 0.10.4

Bem Now lets add a new “Representation’ to more

_ clearly display the mutated residue. First click on
the menu icon beside our loaded entry “1HBS”.
From the menu that appears click
Representation [add] and select spacefill from
the dropdown list of options.

structure

PDB file
Representation

ASSEIMDIY

Superpose

File mmtf. rcsb org/v’

Trajectory

This will result in all atoms of our entry being
displayed as so called “sapcefill spheres” with
different atom types in different colors (e.g.
oxygens in red, carbons in gray etc.)

Principal axes
Annotations
Validation
Position

Rotation

Scale

We now want to limit the atoms shown in “spacefill” to be be only those of our
mutated amino acid (namely Val 6 in Chain H).

In the white box beside the new “spacefill” item

NGL Viewer 0.10.4 .
enter the selection text 6:H

-] W

This will lead to only residue number 6 of chain H
being rendered as spacefill. Play around with the
settings from the spacefill menu and selection text
until you have a reasonable feel for how the
program works. Can you see mutated residue
position?

@ 2HBS @ [}

v

@ cartoon

@ ball+stick

T _ Try zooming (via scrolling up and down) and rotating (via
) L2 1] clicking and moving your mouse). You can always

A “reset” the view by clicking the target like circular icon.
Also experiment with different settings and views.

Q18: What do you notice about the location of the Val6 residue in chain H of the
2HBS structure in relation to porphyrin?
[HINT: see Figure below where | have used a white “licorice” representation for Val6.]
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In this representation,
one of the central

Lo~
a3
. g

Q’ P> @ mutant B chains is
8 highlighted in orange
ribbon. Also
highlighted is the side

chain of the E6V (i.e.
Val6) mutation (white)
and porphyrin
prosthetic group (ball
and stick
representation).

NOTE: Some folks have reported issues using the NGL with older versions of the
Chrome browser. The workaround is to use a different web browser. If, the structure is
still not displayed correctly for you, download its coordinates from the PDB database at:
http://www.rcsb.org/ and ask for assistance.

Discussion:
The original paper discussing the 1HBS and 2HBS crystal structures is available online:

http://www.sciencedirect.com/science/article/pii/S0022283697912535

In this article, Figure 3 demonstrates how the Glu6->Val6 mutation could result in the
characteristic "sickle" phenotype. The charged Glu6é mutating to Val6 creates a
superficial hydrophobic patch on one HbS molecule that interacts with hydrophobic
surface residues of another. The molecules thus polymerize, creating extended fibers
that distort the shape of the red blood cell.

Assessment of the disparate biochemical properties of normal and sickle haemgolobin,
together with microscopy studies showing long crystal fibres inside sickle cells, led
Linus Pauling (1949) to (correctly) predict the morphological effects of these changes.
The abnormal sickle form causes the cells to clump together, hampering their passage
through blood vessels, depriving tissues of oxygen. See this YouTube video for an
illustration: http://www.youtube.com/watch?v=QdOHrY2NIwY

The sickled blood cells have a short lifetime and cannot be replaced fast enough,
leading to chronic anaemia. Sickle cell anemia was one of the first diseases to be linked
to a defect at the molecular level, providing a clear demonstration that a single base
mutation can change a single amino acid, which in turn can result in a defective protein.
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Q19: What one part of this exercise or associated lecture material is still confusing?
If appropriate please also indicate the question number from this document and
answer the question in the following anonymous form:

Mudy Point Assesment Form

[Your comments will let us know which material needs to be further clarified and will
help us gain stronger control of the material in this course. Thank you!]
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Appendix

>gi|179408|gb|M25079.1 | HUMBETGLA Human sickle cell beta-globin mRNA
ATGGTNCAYYTNACNCCNGTGGAGAAGTCYGCYGTNACNGCNCTNTGGGGYAAGGTNAAYGTGGATGAAG
YYGGYGGYGAGGCCCTGGGCAGNCTGCTNGTGGTCTACCCTTGGACCCAGAGGTTCTTNGANTCNTTYGG
GGATCTGNNNACNCCNGANGCAGTTATGGGCAACCCTAAGGTGAAGGCTCATGGCAAGAAAGTGCTCGGT
GCCTTTAGTGATGGCCTGGCTCACCTGGACAACCTCAAGGGCACCTTTGCCACACTGAGTGAGCTGCACT
GTGACAAGCTNCAYGTGGATCCTGAGAACTTCAGGCTNCTNGGCAACGTGYTNGTCTGYGTGCTGGCCCA
TCACTTTGGCAAAGAATTCACCCCACCAGTGCANGCNGCCTATCAGAAAGTGGTNGCTGGTGTNGCTAAT
GCCCTGGCCCACAAGTATCACTAAGCTNGCYTTYTTGYTGTCCAATTT

>gi|28302128|ref|NM 000518.4| Homo sapiens hemoglobin, beta (HBB), mRNA
ACATTTGCTTCTGACACAACTGTGTTCACTAGCAACCTCAAACAGACACCATGGTGCATCTGACTCCTGAGGAGAAG
TCTGCCGTTACTGCCCTGTGGGGCAAGGTGAACGTGGATGAAGTTGGTGGTGAGGCCCTGGGCAGGCTGCTGGTGGT
CTACCCTTGGACCCAGAGGTTCTTTGAGTCCTTTGGGGATCTGTCCACTCCTGATGCTGTTATGGGCAACCCTAAGG
TGAAGGCTCATGGCAAGAAAGTGCTCGGTGCCTTTAGTGATGGCCTGGCTCACCTGGACAACCTCAAGGGCACCTTT
GCCACACTGAGTGAGCTGCACTGTGACAAGCTGCACGTGGATCCTGAGAACTTCAGGCTCCTGGGCAACGTGCTGGT
CTGTGTGCTGGCCCATCACTTTGGCAAAGAATTCACCCCACCAGTGCAGGCTGCCTATCAGAAAGTGGTGGCTGGTG
TGGCTAATGCCCTGGCCCACAAGTATCACTAAGCTCGCTTTCTTGCTGTCCAATTTCTATTAAAGGTTCCTTTGTTC
CCTAAGTCCAACTACTAAACTGGGGGATATTATGAAGGGCCTTGAGCATCTGGATTCTGCCTAATAAAAAACATTTA
TTTTCATTGC

http://www.rcsb.orqg/pdb/files/2hbs.pdb

The mutation causing sickle cell anemia is a single nucleotide substitution (Ato T) in the
codon for amino acid 6. The change converts a glutamic acid codon (GAG) to a valine
codon (GTG). Changing a hydrophilic amino acid to a hydrophobic one, see http://
themedicalbiochemistrypage.org/sicklecellanemia.php

Note there is also a T -> A difference at position 162 (162/3 => codon 54 GCT -> GCA).
This is in the third position of the codon and hence does not change the corresponding
amino-acid.
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